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NOTICES 
 

The material in GeoCue Group, Inc. documents is protected by United States Copyright laws.  

 

 

You may make as many copies of this material for use internal to your company as 

you desire.   Please do not distribute this material outside of your company without 

first discussing with us. 

 

 

Trademarks, Service Marks 

 

• Windows and .NET are trademarks of Microsoft Corporation. 

• NIIRS10, GeoCue and CuePac are trademarks of GeoCue Group, Inc. 



Getting Help 

 
We are sure that you will experience different problems with GeoCue that 

range from installation issues to defects that made it through our testing 

undetected.  We hope that you will immediately contact us with any 

problems or questions and have the patience to work with us through a 

successful GeoCue deployment. 

 

Please contact us via phone or email for assistance with or comments about GeoCue and 

PointVue. 

 

email: 

support@geocue.com 

 

Phone: 

1-256-461-8289 

 

Just ask for GeoCue Support and you will get connected with someone who can assist you.  

There is usually someone in the office between the hours of 0600 and 1800 CDT, USA on 

weekdays.  Weekends are sort of hit or miss. 

 

Fax (always on): 

1-256-461-8249 

mailto:support@geocue.com
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1 Introduction 
PointVue is a 3-D LIDAR visualization tool which can be used to visualize LIDAR data in ASPRS LAS 

format. PointVue is included as part of GeoCue LIDAR 1 CuePac and is also available in a stand-

alone version, PointVue LE.  

This Help Guide applies to PointVue as well as PointVue LE.  However, some functionality of 

PointVue (as packaged with LIDAR 1 CuePac) is not available in PointVue LE and will be so noted 

throughout this Help with the following icon:  

PointVue can be accessed through the Checklist in GeoCue LIDAR 1 CuePac, from the Windows 

Start Menu (Programs->GeoCue->LIDAR1 CuePac->PointVue), or through the Setup menu in 

GeoCue: 

 

 

PointVue LE can be accessed from the Windows Start Menu (Programs -> PointVue LE -> 

PointVue LE). 

The main PointVue window contains the following options: 

• File:  This menu category contains menu items that allow you to Open or Close a LIDAR 

file, Cleanup the list of most recently used LIDAR files, or Exit the program. 
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• View:  This menu category contains menu items that provide various viewing options 

(Settings, Top, Bottom, Left, Right, Front, and Back) and display of the elevation color 

map. 

• Tools:  This menu category contains menu items that allow you to view File Information 

and change PointVue settings. 

• Window:  This menu category contains menu items that support window options (tiling, 

creating new windows, etc.). 

• Toolbar:  The PointVue toolbar contains various tools to manipulate the viewing of the 

data. 

2 File 

2.1 Open 

To open a LIDAR file, select Open from the File menu or select a file from the list of most 

recently opened files. 

 

 

 

You can also "drag and drop" a 

LIDAR file onto PointVue. 
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2.2 Close 

To close the currently open file, select Close from the File menu. Closing the file will also close all 

view windows. 
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2.3 Exit 

To Exit PointVue, select Exit from the File menu. 
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2.4 Cleanup MRUList 

This command removes any LIDAR filenames from the Most Recently Used list if the files no 

longer exist. 
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3 View 

3.1 Settings 

3.1.1 Settings 

To see and/or modify viewing options, select Settings... from the View drop down menu. The 

Settings menu is available even if no file has been opened and no view exists. This is to permit 

the editing of settings without having to open a LIDAR file. The View Settings dialog displays the 

view settings for the active view.  The view title will be displayed in the title bar of the View 

Settings dialog.  

 

 

    

 



                                              PointVue User Guide 

 

PointVue 

GeoCue Group Inc.  8 22 December 2020 

Copyright 2020 

3.1.1.1 General 

Selecting the General tab will configure the View Settings dialog as shown below. 

 

 

The General tab on the View Settings window allows you to adjust the following: 

 

Controls the point display coloring 

scheme: 

Depth - The point color is 

controlled by the point elevation. 

Elevations are mapped according 

to the chart shown here, where 

points of lower elevation are 

colored by the left side of the chart 

and points of higher elevation are 

colored by the right side of the 
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chart.  The mapping can be tuned 

via the Depth tab on the dialog. 

  

Return - The point color is 

controlled by the LIDAR point 

return number.  The color 

assignments can be changed via 

the Return tab on the dialog. 

Classification - The point color is 

controlled by the LIDAR point 

classification.  The color 

assignments can be changed via 

the Classification tab on the dialog. 

Intensity - The point color is 

controlled by the intensity value of 

the point using a grayscale color, 

where low intensity points appear 

dark and high intensity points 

appear light.  The color mapping 

can be tuned via the Intensity tab 

on the dialog. 

Source ID - The point color is 

controlled by the LIDAR point 

source ID. The color assignments 

can be changed via the Source ID 

tab on the dialog. 

Classification & Intensity - The hue 

of the point color is determined by 

the LIDAR point classification, but 

the intensity of the point color is 

determined by the intensity value 

of the point.  The Classification and 

Intensity tabs on the dialog can be 

used to tune this color display 

mode. 
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Depth & Intensity - The hue of the 

point color is determined by the 

LIDAR point depth, but the 

intensity of the color is determined 

by the intensity value of the 

point.  The Depth and Intensity 

tabs on the dialog can be used to 

tune this color display mode. 

Source ID and Intensity - The hue 

of the point color is determined by 

the LIDAR point source ID, but the 

intensity of the point color is 

determined by the intensity value 

of the point. The Source ID and 

Intensity tabs on the dialog can be 

used to tune this color display 

mode. 

Return and Intensity - The hue of 

the point color is determined by 

the LIDAR point return number, but 

the intensity of the point color is 

determined by the intensity value 

of the point.  The Return and 

Intensity tabs on the dialog can be 

used to tune this color display 

mode. 

 

 

The point size (in pixels) used when 

drawing the points. 
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View background color. 

 

Color used when drawing the XYZ 

axes.  

 
Maximum number of points to 

display in the view when NOT in 

dynamic rotation mode.  If this 

number is less than the total 

number of points, points appear 

thinned in the display. For 

example, if 10 million points were 

read and Max Points per Update is 

2 million, every 5th point will be 

displayed. 
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Maximum number of points to 

display in the view when 

performing dynamic rotation.  If 

this number is less than the total 

number of points, points appear 

thinned in the display.  For 

example, if 10 million points were 

read and Max Points per Update is 

100,000, every 100th point will be 

displayed. 

 This scale factor exaggerates the z 

values when displaying points.  A 

value of 1.0 provides no 

exaggeration. A value 0f 2.0 

doubles the exaggeration.  A 

negative value will invert the z 

values.  The elevations are 

expanded about the statistical 

median of the data (after applying 

the linear percent clip set on the 

Depth tab of the dialog).  Depth 

exaggeration can also be controlled 

with the wheel on the mouse while 

holding down the SHIFT key.  

 
Depth buffering (on by default) 

enables hidden surface removal so 

points closer to your eye are not 

obscured by points further 

away.  You would only want to 

disable depth buffering if you are 

coloring points by classification or 

source ID and want to honor the 

priority attribute associated with a 

particular class or source ID. 
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3.1.1.2 Depth 

The Depth tab on the View Settings dialog allows you to change the behavior of the view display 

when coloring by depth.  

The easiest way to get a good distribution of colors over the range of elevation values is to check 

the Auto High\Low Z box, which will perform a linear percent clip based on a histogram of the 

elevation values. When Auto High\Low Z is checked, you can change the percent clip applied at 

the upper and lower ends of the histogram by typing in the desired percentages in the High and 

Low %Clip fields. 

If you know the actual high and low Z values over which you want to distribute the full range of 

colors, you can enter those values manually by unchecking the Auto High/Low %Clip box and 

typing your Z values directly into the High and Low Z fields.    The  % clip values are ignored in 

this case. 

When coloring by Depth or by Depth and Intensity, colors are determined by specifying Hue, 

Saturation, and Intensity. The Hue and Intensity values are computed automatically by PointVue 

from depth and intensity information on the LIDAR points. The user may control the color 

Saturation value that is used by changing the Color Saturation slider control.  If you are coloring 

by depth without intensity, you generally get better results with a higher saturation value, but if 

coloring by depth with intensity, you generally get better results with a somewhat lower 

saturation value. 

If you want to manually control how fast the colors change as Z changes, check the “Color 

Transition Interval” box and adjust the Z Interval value.  Note that the colors will repeat every 12 

x Z Interval units of elevation. 

If you want a palette of 12 discrete colors instead of a continuous range of colors, change the 

Gradation Method to Discrete. 
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3.1.1.3 Intensity 

The Intensity tab on the View Settings dialog allows you to change the behavior of the view 

display when coloring by intensity.  In order to get a good distribution of grayscale colors over 

the range of intensity values, PointVue performs a linear percent clip based on a histogram of 

the intensity values.  Here, you can change the percent clip applied at the upper and lower ends 

of the histogram. 
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3.1.1.4 Classification 

The Classification tab on the View Settings window allows you to change the color map that is 

used when coloring by LIDAR point classification. You will be presented with a table containing a 

row for each possible classification value found in the LIDAR file.  PointVue has a default 

classification color map, but you can change the color, priority, and name associated with each 

classification. If depth buffering (accessible on the General tab) is disabled, points of a class with 

a higher priority number will display on top of coincident points with a lower priority number.  

Load 

System 

Classmap  

Retrieves the system classmap from the 

GeoCue repository and displays it in the 

dialog. 

Save 

System 

Classmap  

Saves the system classmap displayed in the 

dialog to the GeoCue repository. The system 

classmap is used by Set Image Generation 

Parameters in LIDAR1 CuePac to compute 

colors for stereo and ortho images made 

from LIDAR data. 

If PointVue is launched within the context of a GeoCue project, PointVue will automatically load 

the system classmap from the GeoCue repository (unless the Auto load GeoCue repository color 

maps option is unchecked in the PointVue Options form). 

If you make changes to your classification color map, you may find it useful to save your view 

settings (which include the color maps) to a file which you can later load to reinstate your 

custom classification color map.  The Load/Save buttons are discussed elsewhere in this 

document. 
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If you select one or more rows of the classification color map (by clicking on the leftmost 

column), the “Edit Rows…” button becomes active.  Selecting “Edit Rows…” displays the “Edit 

Selected Rows” dialog: 
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Checking Change colors will cause the New Color and New Saturation radio buttons to become 

available, which allow you to change the color of the selected rows.  Selecting New Color 

enables the color picker where you can pick the new color for the selected rows.  Setting a color 

to transparent effectively turns off that source in the display.  Selecting New Saturation enables 

the saturation slider, where you can choose a new saturation value for the colors in the selected 

rows. 

Checking Change priorities will cause the New Priority and Set Priorities to Classification radio 

buttons to become available, which allow you to change the priorities of the selected 

rows.   Selecting New Priority enables the field where you can key in a new value for the priority 

of the selected rows (setting all selected rows to the same new priority value).  Selecting Set 

Priorities to Classification will set the priority of each row to the classification value of the row. 

Clicking OK will apply your changes and dismiss the dialog box.  Clicking Cancel will discard your 

changes and dismiss the dialog box. 
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3.1.1.5 Return 

The Return tab on the View Settings window allows you to change the color map that is used 

when coloring by LIDAR point return number. You will be presented with a table containing a 

row for each return found in the LIDAR file.  PointVue generates a return color map 

automatically, but you can change the color associated with each return.  If you make changes 

to your return color map, you may find it useful to save your view settings (which include the 

color maps) to a file which you can later load to reinstate your custom return color map.  The 

Load/Save buttons are discussed elsewhere in this document. 
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3.1.1.6 Source ID 

The Source ID tab on the View Settings window allows you to change the color map that is used 

when coloring by LIDAR point source ID. You will be presented with a table containing a row for 

each source ID.  PointVue generates a default source ID color map automatically based on the 

source IDs in the current file, but you may edit the color and priority values associated with each 

source ID.  If PointVue is launched from GeoCue within the context of a GeoCue project, 

PointVue will automatically load the source ID color map associated with the project (if it exists 

AND the Auto load GeoCue repository color maps option is unchecked in the PointVue Options 

form.  If depth buffering (accessible on the General tab) is disabled, points of a source ID with a 

higher priority number will display on top of coincident points with a lower priority number. If 

you make changes to your source ID color map, you may find it useful to save your view settings 

(which include the color maps) to a file which you can later load to reinstate your custom source 

ID color map.  The Load/Save buttons are discussed elsewhere in this document. 
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Load 

Source 

ID 

Color 

Map 

 

If PointVue is launched from GeoCue within the context 

of a GeoCue project, the Load and Save Source ID Color 

Map buttons are enabled.  

Selecting Load Source ID Color Map reads the map (if it 

exists) stored in the GeoCue repository that is 

associated with the current project.  PointVue will also 

add to the map any source ID’s from sources that have 

been added to the project since the source ID color map 

was saved to the repository.  These new rows will have 

a priority of 0 and a randomly assigned color. 

Save 

Source 

ID 

Color 

Map 

 

Selecting Save Source ID Color Map saves the map to 

the GeoCue repository for the current project.  When 

saving the color map, PointVue will also add to the map 

any source ID’s from sources that exist in the project 

but are not included in the current PointVue map. 

 

If you have one or more rows selected, the Edit Rows… button is enabled.  Selecting Edit Rows… 

causes the Edit Selected Rows form to display: 
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Checking Change colors will cause the New Color and New Saturation radio buttons to become 

available, which allow you to change the color of the selected rows.  Selecting New Color 

enables the color picker where you can pick the new color for the selected rows.  Setting a color 

to transparent effectively turns off that source in the display. 

Selecting New Saturation enables the saturation slider, where you can choose a new saturation 

value for the colors in the selected rows. 

Checking Change priorities will cause the New Priority and Set Priorities to Classification radio 

buttons to become available, which allow you to change the priorities of the selected 

rows.   Selecting New Priority enables the field where you can key in a new value for the priority 

of the selected rows (setting all selected rows to the same new priority value).  Selecting Set 

Priorities to Source ID will set the priority of each row to the source ID value of the row. 

Clicking OK will apply your changes and dismiss the dialog box.  Clicking Cancel will discard your 

changes and dismiss the dialog box. 
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3.1.1.7 Save Setting Changes 

Changes to the View Settings can be Saved and Loaded for future use. Once the desired 

configuration is set, click the Save...button and assign a file name.  This configuration can be 

accessed at any time by clicking the Load... button.  You can return to the Default settings at any 

time by clicking the Default button. 

You can also Apply any view settings you have changed and update the active view without 

leaving the dialog. 
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3.2 Top 

Selecting Top from the View drop down menu gives you a "top" view of your data. 

 

3.3 Bottom 

Selecting Bottom from the View drop down menu gives you a "bottom" view of your data. 
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3.4 Left 

Selecting Left from the View drop down menu gives you a "left" view of your data. 

 

3.5 Right 

Selecting Right from the View drop down menu gives you a "right" view of your data. 
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3.6 Front 

Selecting Front from the View drop down menu gives you a "front" view of your data. 

 

3.7 Back 

Selecting Back from the View drop down menu gives you a "back" view of your data. 
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3.8 Elevation Colors 

Selecting View Elevation Colors from the View drop down menu allows you to see how colors 

are currently mapped to elevation when a view is coloring by depth (or by depth and intensity): 

 
 

 

If the active view is NOT coloring by depth (or depth and intensity), the color map will be 

displayed as follows: 
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Checking the “Keep on top” checkbox will cause the elevation color map to stay on top of all 

other PointVue windows. 

The elevation color map can also be turned on/off via  icon on the toolbar. 
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4 Mouse Options 
You can zoom in and out of the view at any time by rolling the mouse wheel away from you to 

zoom out and towards you to zoom in. The zoom in/out direction of the wheel can be changed 

via Options on the Tools menu. 

If you hold down the SHIFT key while rolling the mouse wheel, you can change the z 

exaggeration. 

You can pan the view at any time by pushing down the middle mouse button then dragging the 

mouse. 
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5 Tools 

5.1 File Information 

To view file information, simply select File Information from the Tools drop down menu. File 

information includes most of the fields in the LIDAR file header. 
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5.2 Options 

From the Tools drop down menu, select Options to set the Maximum number of points to read, 

Invert Mouse Wheel Direction, and Auto load GeoCue Repository color maps. 

 

 

 Max number of points to read:  The default value is 10 million points.  If you notice that your 

system performance degrades when opening large LIDAR files, you may want to lower this 

value.  If this number is less than the number of points in a file you are opening, points are 

skipped at a regular interval as they are read in.  For example, if the file contains 20 million 

points and the maximum number of points is 10 million, then every other point will be read into 

memory.  If you change this setting while a file is already open, PointVue will ask you if you want 

to reread the file (if your change will actually affect the number of points read in). NOTE: The 

max number of points to read is persisted between sessions on a per user basis. 

Invert Mouse Wheel Direction:  The wheel direction for zooming or changing z exaggeration in 

the map view can be changed by checking the box next to "Invert Mouse Wheel Direction". 

Auto load GeoCue repository color maps:  When checked (the default behavior), the 

classification and source ID color maps (if available) will be automatically loaded from the 

GeoCue repository when PointVue is invoked. 
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6 Window 

6.1 Standard Window Tools 

PointVue has the standard Window options as listed below. 
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7 PointVueToolbar 
The PointVue Toolbar consists of: 

 

 Open 

Allows you to open a file. You can also "drag and drop" a LIDAR file 

onto PointVue. 

 Zoom In 

You can "zoom in" for a close-up view of the data. Select this tool 

and then place the cursor over the point in the map display that 

you wish to zoom about.  The display will zoom in by a factor of 

two each time you press the left mouse button. You can also use 

this tool to 'drag' a display rectangle.  With the Zoom-In tool 

selected, place the cursor over one corner of the area you wish to 

display.  Press and hold the left mouse button and drag the cursor 

to the opposite corner of the rectangle you wish to display.  When 

you release the button, the map view will zoom in and display the 

contents of the rectangle. 

 Zoom Out 

You can "zoom out" to see more of the data at a reduced size. 

Select this tool and then place the cursor over the point in the map 

display that you wish to zoom about.  The display will zoom out by 

a factor of two each time you press the left mouse button. 

 Pan 

Allows you to "pan" your data to the desired location. After 

selecting this button, place the resultant "hand" cursor over the 

map display.  Press and hold the left mouse button to drag the 

view to a new display location. 

 Rotate 

Allows you to dynamically rotate the 3D view of the 

data.  When  in rotate mode, holding down the left mouse button 

and dragging inside the view will allow you to dynamically rotate 

the view. 

 Select 

Displays XYZ coordinates in the status bar as you move the mouse 

over point data. 

 Fit Allows you to Fit the all data in the map view. 
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Color by 

Depth 

The Depth tool button causes the point color to be controlled by 

the point depth value. 

 

Color by 

Intensity 

The Intensity tool button causes the point color to be controlled by 

the point intensity value. 

 

Color by 

Classification 

The Classification tool button causes the point color to be 

controlled by the LIDAR point classification value. 

 

Color by 

Return 

The Return tool button causes the point color to be controlled by 

the LIDAR point return number. 

 

Color by 

Source ID 

The Source ID tool button causes the point color to be controlled 

by the LIDAR point source ID value. 

 

Apply 

Intensity 

The Apply Intensity tool button is a toggle that causes the LIDAR 

point intensity to be applied to the currently active coloring 

mode.  So, for example, if the coloring mode is “Color by Depth” 

and the “Apply Intensity” toggle is active, then the realized 

coloring mode is by “Depth and Intensity”. 

 Axes Toggle The Axes Toggle tool button allows you to turn the axes on and off. 

 

Elevation 

Colors 

The Elevation Colors tool button allows you to see how colors are 

currently mapped to elevation when a view is coloring by depth (or 

by depth and intensity). 
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8 PointVue Status Bar 
The PointVue status bar is shown below: 

 

 

The status bar consists of 3 panes outlined below: 

Status Pane – The left-most pane displays temporary status information relevant to the 

operation at hand.  The types of information displayed include: 

• The XYZ coordinate information (when in Select mode). 

• Number of points read so far when opening LIDAR files. 

• Z Exaggeration value when it is being changed via the mouse wheel. 

• User prompts as required. 

Progress Pane – When performing time consuming operations (e.g. reading LIDAR data from 

disk), the middle pane contains a progress bar as shown below: 

 

 

 

Point Density Pane – The right-most pane always indicates how much of the LIDAR point data 

was read from the disk file.  The point density pane will contain one of the following strings: 

• “Data is full resolution” – All of the point data was read from the file. 

• "Data Thinned 1:N” – The number of points in the LIDAR file exceeded the “Max number 

of points to read” parameter.  Therefore, one of every N file points was read. 

• “Data truncated to N out of M points” – The user selected “Cancel” during the file read 

which terminated the file read operation after reading in the first N points.  NOTE: 

PointVue determines whether to thin the data prior to reading in the data.  If the user 

cancels the read on thinned data, the truncated data is thinned as well. 

When reading in a LIDAR file, the status bar also contains a “Cancel” button at the far 

right.  Clicking “Cancel” during a file read will halt the reading of the LIDAR data, but what data 

has already been read in will still be displayed. 
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